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Introduction

Computers can make your life more complicated and full of stress, or they can work
for you and organize your free time. The choice is yours. With a little effort you can
choose the latter and be highly productive. The key to using the computer as a tool
is getting organized. “l have my system” you say? “l get the important things
done.” | am sure this is true, but wouldn’t you like some additional time for that
other project or for some stress relief?

There are many tools and methods for getting organized. This paper will walk you
through organizing your work and your life using the popular but under utilized tool
Microsoft Outlook. You may use Outlook every day and not realize how much more
it can be doing for you. We will discuss advanced rule usage, categorizing, and color
coordination. We will then use these tools to set goals and prioritize. This document
is intended for users that already have and use Outlook.

This is a screenshot of my Outlook screen before doing anything to organize it.
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It looks just like a long list of work to me. What | need is to get directly to what is
most important and most urgent. Come with me through the following sections as |
get myself more organized.

* Rules to the rescue!
e Categorizing is fun
e Color Coordination
* Prioritize your Goals



Rules to the rescue!

I will start with the currently displayed email. It is from a person at work and is sent
to some technicians | manage. | don’t directly need this email but | get a copy
because | am the manager. | will create a folder and a rule to move this, and others
like it to that folder for me. That way | have them if | need them but they don’t get
in my way.

To create the folder, right click on “Inbox” and click “New Folder”. (Shown below.)
Enter a name and click “OK.” | will call my folder Helpdesk.
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The next step is to make the rule that will move email into the folder and optionally
mark it as read. First click on the tools menu and the click “Rules and Alerts...”
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Next click the “New Rule button™
and the Rules Wizard will start. For
this instance | will use the default
selection of “Move messages from
someone to a folder” and click Next.

These emails always come with the
same words in the subject line so |
will select the second option as shown
in the image below. The confusing
part here is that | must now look
down on this screen to the section
called Step 2 and click on the
underlined words “specific words” in
order to enter them.
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Now | can enter the text that will trigger the rule. | enter VPR Help Desk Request
and click “Add.” If you don’t see your text listed in the Search list area you still need
to click Add. Next I click “OK.”
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More advanced rules

The last step is to give the rule a name and turn
it on. Since | have a lot of these | will also make
the selection “Run this rule now on messages
already in ‘Inbox’.” 1 click “Finish” and the gerbil
in my computer starts running.

After some work all emails with VPR Help Desk
Request in the subject line are moved to the
Helpdesk folder unless they were sent only to
me. This will happen to all future email as well.

I know you get the gist of it now so try some of these on for size. Try to make a rule
that will delete that annoying spam you get almost every day. You know the one,
“Real fake watches” or those pills that you are just not interested in. If you are like
me a certain number of spam messages are the same thing over and over. Have
your rule delete it or move it to a spam folder.

Challenge me you say? Make a rule that will have your computer play a sound when
a message from your boss arrives. No not the theme for the death star, just
something to get your attention on an important message.

Deal with more people that just one boss? Make rules to apply a colored flag to
messages from those you need to see. | mark some clients with orange, purple, and
yellow flags so they stand out to me.

Here is another look at
my Outlook. | have

added some folders under
my inbox, and made rules
to sort my mail for me. It

looks a little more
manageable but we are
still not done.

Categorizing is fun
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items into categories will help me find them when | need them. Grouping by



category will simplify how | see all that email. Outlook does some grouping and
categorization for you. For example, click on the “View” menu at the top and then
click “Arrange By” and then date. Next click on the “View” menu at the top and then
click “Arrange By” and then “Show in Groups.” Your Arrange By menu should look
like the one pictured below.

Inbox - Microseft Outlook

: Fle Edi Go  Tools  Actions  Help Type & question for help =
Pgilew - | drrange By b “T Date BoFind [ | G Typeacontacttofind = | (@)
Reading Pane » Conversation
[ ey AutoPreview From
@ Inbox ExpandfCollapse Groups » To
Lo Unreadg Toolbars » Falder
L) For ol 2
e E
Sent It 9 _ 22
Subject
All Mail Folders (=1 Drew,Bro e
=) €5F Mailbox - Drew Brown 20065 Tepe
) 3 Deleted Ttems (= Michael R Flag
Z006Suri
@ Drafts [1] Attachments
= [ mbox (3) (=1 Dartin.Mg
3 Applicants 20065 E-mail Accaunt
[ Helpdesk Irnportance
[ Mar stuff Yesterda :
[ MailList Categories
[ save Sunday Custor, ..
E Junk E-mail (1)
@ Cuthox Last Wedll2 Show in Groups
[ Quarartine Show Yiews In Navigation Pane
(4 Sent Items Two Wesl
# [ Search Folders Current Yizw

Three Weeks Ago

Last Month

Older

1053 Items Updating Sent Items. This Folder is up to date, Connected +

Outlook will add a plus/minus sign next to each set of emails organized by date.
Clicking it will expand or collapse the group. Doesn’t this look more manageable?
Now | only see the email from today. Alternatively, | could make a category called
“Done.” Then as | am done with an email that | want to keep | add it to that group.
It will stay in my inbox but | can click the plus/minus sign and close it from my view.

Making your own categories lets you do more that just group by date. This is the
time management piece you have been waiting for. Consider this, at any given
moment you have a certain amount of email on your computer. Some email is
critical and must be taken care of promptly. Other email is important, but not at the
mission critical stage. Lastly a lot of email is not important at all. Not to say that it
is junk mail, but it is the background noise around your life. | will label these three
categories category-critical, category-important, and category-normal. You will see
why | put category- in front in a moment.

In Outlook, click on the “Edit” menu and then “Categories.” In the box that opens up
type in Category-Critical and click “Add to List.”
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Next type in Category-Important and click “Add to List.” Do the same for Category-
Normal. When you are done you can remove any that are checked. Your screen
should look like the one pictured below. When it does, click “OK.”
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Notice my Critical, Important, and Normal are
listed together because | put Category in front.
You could abbreviate this to be C-Critical if you
want. Now it is time to label your email with
these categories.

Right click a critical email and click “Categories.”
Then click the Category-Critical selection and
click OK. Do the same for an important and
normal email. After you have categorized a few
to try this out, click on the “View” pull down
menu, “Arrange by” and Categories. Your
screen should look something like this.
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Now at any given time | can look at my email in the order of importance, rather than
simply when they arrived. Most of your email will still be in the “none” category.
Here is the first of two time saving tips for categorizing email. You can right click on
an email and choose “Categories” and then press the “C” on your keyboard once to
highlight Category-Critical, a 2" time to highlight Category-Important, and a 3™ to
highlight Category-Normal. When the right one is highlighted, press the spacebar
and then the enter key. The next time saving tip is to create a rule that will
categorize your email for you. Have it search for project titles, or depending on who
the email is from. If a rule sets a category, you can always adjust it later.

I think you get the idea with email, so | will simply say that categories are a huge
help for Outlook tasks. Assign each task a category and then when you are planning
your day or have some time, tackle the top ones first.

Color Coordination

Use your calendar to schedule time for your important projects. Marking email and
calendar items with certain colors will help you see what your day is like at a glance
and will also help you know how to handle interruptions.

For example, below is a picture of my calendar without any coloring. A client wants
to meet with me on Thursday but as you can see my day is full. This is an important
client so I need to make time and | need to make them feel like | don’t hesitate to

make time for them.
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The first step is to categorize the items on my calendar. To do so, | can open each
item and click the “Categories” button in the lower left corner of the screen.

Next | need to decide which color will indicate each of my three major categories.
Click the “Edit” pull down menu, then “Label” and then “Edit Labels.” You can see in
the example below that | have only changed the names of the top three colors
Outlook gives me. | made red Critical, blue Important, and green Normal. After
changing the names to how you want them, click “OK.”
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Mame: |Critical |
Lahel: " |
[ k. l [ Cancel l

Next click the “Condition” button. A new window will open and you will click on the
“More Choices” tab. From there click the “Categories” button and select “Category-
Critical” as indicated below.

Filter (%

Appaintments and Meetings| More Choices |Advanced Click “OK” and then do the same

[Cotegories... | |category-Critical v for the other two categories.

| After all three have been added
click “OK” to get back to your

| calendar. Any items you have

[Jomby items that are:

[T omby items with:

set to be in one of the three
categories should be the color
you selected. Here is a picture

|
|
|:| Whose impaortance is: |
|

[J by ikems which:

[ ttatch case of my calendar with each item in
Size: (Klobytes) a category and Outlook applying
| dossrt matter v | | | | the colors | selected.

[ a4 ][ Zancel ][ Clear Al ]




Calendar, - Microsoft Outlook @ g@gl

I Fle Edit Wiew Go Tools Actions  Help Type a question For help =

PEHNew - | X i g4 | Today | [1]Day | 5]wark Week | 7]week [37]Manth | ‘pr[nd | G Type acontacttofind = | (@) e E;, !

Calendar | Look for: - SearchIn~ Calendar Find Mow Clear Options ~ X |

4 lunezio6 3 Calendar June 12 - Lne 16
SMTW I ; ; Monday, Jun 12 Tuesday, Jun 13 wednesday, Jun 14 Thursday, Jun 15 Friday, Jun 16 ~
45 678 910 Flag Day {United States)
1112131415 16 17 am
1619 2021 22 23 24 5
2526 27 28 29 30
6 oo
July 2006
SMTWTFS 700 Deentist €2 Helpdesk operations
1
2345678 8 0
910 1112 1314 15
16 171819 20 21 22 MeAfee demo (Coor
23 24 2526 27 28 29 9 o L1-74)
031 3 Patch Tuesday
My Calendars 10 oo ©« ;fTe:tmrg mE‘et\ng
Calendar Project Plan update
o0 (conference room)
Other Calendars 1 1
] m.room.ADME. 1634 =
Lunch Meetin
[ Gary Delago 127 a e
[ Russell Mahn iris Demo
[ 10n sheehan 1 i} [:] Sharepml;rt_ Tun
[ allen Anderson (Garys Office)
[ Judy Harris 2 oo
Open & Shared Calendar. .. = T
ack up the Cave
Share My Calendar, . 3
M2 3:300m-3:45pm ched|
4 oo
[uli}
.~ Mail 5
.aj Calendar 6 oo
844 L] 4 (Z 2 —om =
11 Items Ii—l Onling

Now back to my client. | need to bump something from Thursday. The item called
Altiris Demo is a normal priority while the others are important or critical. | can
quickly see when | should meet with my client.

Prioritize your Goals

Everything takes time. You should take some time and write down your personal
and career goals. Actually write them down, don’t just think you know what they
are. Enter each goal as a task in Outlook. Then rate each one as Critical, Important,
or Normal. Each week schedule on your calendar a planning session for that week
(mark it as a critical appointment.) My planning session is normally Sunday night.
During your planning session set time you’re your calendar to work on your most
critical goals. Some goals take years with others may take hours. Spend a little
time each week on those bigger goals.

Don’t be afraid to change how you categorize your goals. Priorities can change. Be
willing to add new goals to your list. And to your life.




